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Verifier Help

What is Verifier?

Brainware Intelligent Capture is a product suite designed for automatically processing incoming documents.
BIC can process documents from arbitrary physical sources and paper-based documents as well as from

electronic files, email, or faxes.

Verifier allows users to validate and correct extracted data.



What happens when Verifier processes documents?

Structured or unstructured document input is obtained by scanning paper-based documents from fax
servers, email servers or as files. All documents are stored on a computer’s hard drive. BIC monitors
specified directories on this hard drive for new documents. If BIC detects new documents, the system
imports them.

BIC first analyzes the imported documents to determine the document layout and to recognize
structures such as words, lines, logos, or tables.

BIC then classifies the documents according to predefined categories. Examples of typical categories
used in classification are invoices, orders, offers, or resumes. You can define categories individually,
depending on the needs of your organization. Using a set of sample documents, the system actually
learns to decide to which category a previously unknown document belongs to.

For each category, the data relevant for further processing is different. For example, if you are
processing invoices, you probably want to know the total sum to be paid. This information is irrelevant if
you are processing resumes, where the applicant’s name, the desired position, and the contact options
are more important. BIC identifies and extracts data that is relevant for the respective document
category. You can individually define the data that BIC extracts to suit the needs of your organization

Finally, the documents, their category assignments, and the extracted information are released from the
system and written to designated export directories. The documents are then forwarded to connected
systems. For example, invoices can automatically be forwarded to the software system used in your
company’s accounting department, while resumes are sent to Human Resources.

All this is done without human intervention once the application has been set up. But what happens if
BIC cannot properly process a document? There are several reasons this could happen.

« Paper-based documents might be illegible.
« There might be stamps or notes on the documents that make important sections illegible.

« BIC may encounter a document from an unknown category. Since the software was not previously
trained to recognize documents from this category, it is not able to process the document.

« BIC tries to extract information that is missing, such as from an incompletely filled in form.

That is where Verifier comes in: is the quality assurance utility of the product suite. The program detects
all documents with processing problems and presents them to the user for verification.

Since the verification step precedes the export step, only qualified output can leave the process.
Therefore, subsequent systems only receive appropriate input.



Verifier key features

« Allows central database storage of projects and of user authentication information for more flexible
access.

« Allows convenient correction of automatic classification results.

« Allows convenient correction of automatic extraction results.

« Allows manual indexing of documents.

« Allows semi-automatic indexing of documents by means of database lookups.
« Allows afinal check of corrected documents before releasing.

Verifier functionality highlights

« The structured user interface makes the program easy to learn.

« Sophisticated status management and filter techniques display only the documents you have to
check.

« During the application design, the user interface is configurable, providing optimum display options
for each document category.

« Keyboard shortcuts are available for most operations, enabling you to get your job done quickly.
« Through automatic locking, teams of users can safely process document batches.

Explanation of Terms

To properly ensure the quality of automatically processed documents, it is important to understand the
following information.

Batches are the basic entity.

Brainware Intelligent Capture (BIC) works on batches and will completely process one batch before
processing the next. Verifying and approving entire batches before routing to subsequent systems is an
important step since batches are the basic entity.

A batch is only valid if all of its parts are valid.

Since BIC deals with information and data, the application uses the terms “valid” or “invalid” instead of
“working” or “damaged.” The restrictions on the number of parts and the well-defined relationships
makes it easy to understand why a batch is invalid.

A batch is invalid if:

One or more folders inside the batch are invalid.

A folder is invalid if:

One or more documents inside the folder are invalid.

A document is invalid if:

The automatic classification result is incorrect or if the automatic extraction result has invalid fields.
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A classification result is invalid if:

The class still needs validating or the matching class was not found.

A field is invalid if:

The field content still needs validating, the field content does not comply with the validation rules, or
filling-in the field is simply unfeasible.

There are a few reasons for violating field validation rules.

« Restrictions on the number of characters.
« Allows only uppercase characters.
« Checking the questionable results from the OCR process, which are red and underlined.

About Brainware Intelligent Capture Workflow

In Brainware Intelligent Capture, the flow of incoming documents follows a sequence of standard processing
steps. One of the objectives of Brainware Intelligent Capture is to get documents to their recipients as quickly
as possible.

Runtime Server executes automatic steps that include document import with batch creation, OCR and layout
analysis, classification, extraction, export, and clean-up. After the automatic steps there are two manual
verification steps for quality control.

If Runtime Server detects that the batch contains invalid results, the user manually analyzes and resolves the
problem. Invalid batches appear in a task list called Batch View. When Brainware Intelligent Capture finishes
processing a batch, the documents are sent to their recipients.

Start Verifier
Log On
To log on to Verifier, complete the following steps.
Note: The Remember password option is deprecated and no longer taken into account.

1. Launch Verifier.

2. Inthe Brainware Intelligent Capture Project Logon dialog box, enter you user name and password.
Note: The project administrator specified your user name and password in Designer. The password is
not the same as the one you use to log on to your workstation. Instead, it is specific to Verifier, and
possibly to the project. However, you probably have the same user name and password for all Verifier
projects you work on.

3. Click OK.

Note: When launching Verifier for the first time, the Batch List View is empty and an error message
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displays if Verifier is not yet configured.
Verifier displays the Batch List View.

Log On Using Command Line Arguments

To suppress the login dialog when starting Verifier, you can use command line arguments. Complete one of
the following actions.

o Tolaunch Verifier fromthe [ITnstallation path]\Brainware Intelligent Capture\bin
directory, complete the following substeps.
o Inthe [Tnstallation path]\Brainware Intelligent Capture\bin directory,
create a new batch file and give it a meaningful name, such as LaunchVerifier.bat.

» Copy the following line to the batch file, replacing User name with the user name and
password with the password.
Example start /B DstVer.exe /USR "User name" /PWD password

« Save and close the file.
» InWindows Explorer, double-click the batch file.

o Tolaunch Verifier from a location otherthanthe [Installation path]\Brainware
Intelligent Capture\bin directory, complete the following substeps.
» Create a new batch file and give it a meaningful name, such as LaunchVerifier.bat.

« Copy the following line to the batch file, replacing User name with the user name and
password with the password.

Example " [Tnstallation path]\Brainware Intelligent
Capture\bin\DstVer.exe" /USR "User name" /PWD password
« Save and close thefile.
« InWindows Explorer, double-click the batch file.

« Tolaunch Verifier from the Windows Run application, complete the following substeps.
« From the Windows Start menu, select Run.

« Inthe Run dialog box, in the Open field, enter the following command, replacing User name with
the user name and password with the password.

Example " [Installation path]\Brainware Intelligent
Capture\bin\DstVer.exe" /USR "User name" /PWD password

About Roles

Depending on their assigned role, users are able to complete the following tasks.
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« Define, modify, and maintain the learnset.
« Collect and manage local training data.

« Propose learnset candidates to improve the performance.

« Verify the documents that Runtime Server could not automatically process.
« Access and change the batch filtering properties.

« Access and change the settings.

For more information, see "Users, groups, and roles" in the Brainware Intelligent Capture Designer Help.

Change your Password

To change your password, complete the following steps.

From the Options menu, select Change Password.
Optional. To display the passwords, select Decode password.
In the Old password field, enter the current password.

A WO DN -

In the New password field, enter the new password.

Note: The minimum character length for a password is 7, the maximum character length is 20. The
password must include both alphanumeric and numeric characters.

5. Inthe Confirm new password field, reenter the new password.
6. Optional. Select Update password in Database.
This option is available if Allow Database Authentication is enabled for the userin Designer.

For more information, see "Create a User" in the Brainware Intelligent Capture Designer Help.

7. Click Apply and then click OK.
Verifier Configuration

About Configuring Verifier

You can only change the Verifier settings if you have been assigned the Verifier Settings (SET) role.

Configuring Verifier entails specifying which batches of documents are processed at a given station. This
includes the following.

« Sourcing of the batches either from the file system or from the Brainware Intelligent Capture database.
« Thelocation of the batches in the file system.

« The Designer project file that contains the settings used to process the documents.

« The processing steps that you want to verify: classification, extraction, or both.

« The status of batches before and after processing.
It also entails configuring 508 Compliance, but this is done at the workstation level, not the project level.



After you configure a project’s settings, you can load and save them using commands on the File menu.
When loading or saving a project you can load or save a file with or without network data. When loading, click
on the file type drop down box and select either <project name> (*.sdp), or <project name> skip learn data

(*.sdp).
Configure Verifier
To configure Verifier, complete the following steps.

1. Onthe toolbar, click the Settings “# button.
2. Configure the settings as described in the following topics.

General Settings

Define the Project File

The project file contains the forms used to verify the extraction. To define the project that processes the
documents, complete the following steps.

1. Inthe Brainware Intelligent Capture Verifier Properties dialog box, select the General tab.

2. Complete one of the following substeps.

« To specify the project file that processes the documents, click Use project file and enter or
browse to the path and file name of the BIC project. The project loads after retumning to the Batch
View.

« Tospecify a project referenced in the batch control file, click Use batch specific project file.The
project loads each time you open a batch.

Note:

If you use this option, ensure that the Allow Database Authentication option is selected for all
users in Designer. For more information, see "Allow database authentication" in the Brainware
Intelligent Capture Designer Help

The title bar indicates the currently loaded project.

Define Directories

Under Directories, complete one the following substeps.
« Tostore BIC core information in the database, complete the following substeps.
+ Select the Use database as document and statistics source check box.
» From the Select Job list, select a job.

« To specify the number of batches displayed per page, select the Display check box and modify
the value in the [xx]Jbatches per page field, if required. The valid range is from 1 to 200.
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o Tostore BIC core information in the file system, complete the following substeps.
o Clearthe Use database as document and statistics source check box.

« Inthe Batch Root field, enter or browse to the directory where the batch control files are located.
» Inthe Image Root field, enter or browse to the directory where the scanned images can be found.
For more information, see About Batch Root and Image Root.

About Batch Root and Image Root

Batch Root

The Batch Root directory is where the batch control files are located. This directory also includes alicense
directory where you can find the network license file. When multiple instances of Runtime Server and Verifier
are running, they will check this directory for the network license file. If you use different Batch Root
directories simultaneously, you can set up a specific path for the network license. However, you can only
configure this path manually for Runtime Server and Verifier. This option is not available when using the
Brainware Intelligent Capture database.

Image Root

The Image Root directory is where subdirectories with the scanned images can be found. As a rule, Batch
Root and Image Root should be the same. In special cases, for security reasons for example, the Image Root
can be different from the Batch Root.

About Client Settings

The Client option refers to the intent to use client-specific variables.

Currently, only the default setting is available. In Designer, project administrators can define global variables
for different clients.

With the default entry, global variables do not vary by client.

Define Batch Options

Under Batch options, complete the following steps.

1. Toautomatically display newly generated batches with matching states in the Batch List View, select
the Automatic batch refresh check box.

Note:
To manually refresh the Batch List View, click View > Refresh.

2. Toenable Verifier users to create new TIFF files when a workdoc is split into multiples, select the
Create new image file when cutting document check box. The TIFF files correspond to the new
workdocs.

Note:



This feature is disabled when the Use database as documents and statistics source option is
enabled. Any project that wants to use this feature needs to use the file system instead of the
database.

3. Toenable Verifier users to cut a long document, such as a multi-page fax, into several shorter
documents while still retaining the cover page of the original workdoc as the cover page for each of the
newly created shorter documents, select the Enable cut keeping cover page option.

Note: You must repeat the OCR processing for the new documents.

This provides additional menu items in the shortcut menu in Document Separation Mode.
Define Fields Edit Mode

The fields edit mode determines how to initially select the content of a field. When the Verifier form appears,
the cursor automatically places in the first invalid field at the beginning of the current content. Under Fields
edit mode, complete one of the following substeps.

« To place the cursor before the current content without any text pre-selected, select Insert.

o To pre-select the current content such that entered text replaces the current content of the field, select
Overwrite.

Define Tabbing Behavior

To enable the user to skip all valid fields and tab through invalid fields only, complete the following step.

Note:

When the user presses Tab inside a table control, the system tabs through invalid table cells only. This
option also applies for tabbing backwards by pressing Shift + Tab.

« Under Advanced, select the Tab through invalid fields only check box.

About 508 Compliance

The Enable 508 Compliance option is helpful for people with visual impairments.
This option provides the following features.

« A blue arrow points to the field that has focus.

« Ifinput focus is lost, the user can manually restore the focus by pressing Ctrl + N or by clicking View >
Restore Focus

« The user can activate pop-up menus for workflow state lists and exception handling by pressing the right-
click key. This key is located on the right side of the standard keyboard, between the Windows key and
the Ctrl key.

« In Show Selected Batch, the right-click key activates the shortcut menu for Append this document to
previous one and Cut pages into a new document.



« During document verification, the user can activate the shortcut menu for the current item by pressing
Ctrl + M or by clicking Image > Show Selection Context Menu .

« Blue rectangles without icons in the highlight columns for the interactive learning mode indicate
unmapped column items.

« Rectangles with a valid/invalid icon on its left side indicate a valid/invalid column item.

« Additional visual indicators besides color highlighting help distinguish between invalid fields, valid fields,
and questionable fields. These indicators are present in table fields and form fields. Green check marks
show valid fields, red X's show invalid fields, and orange question marks show questionable fields. Field
candidates highlight in yellow, but do not have additional validity icons.

Enable 508 Compliance

To enable the 508 Compliance settings for your workstation and projects, complete the following step.

« Onthe General tab, under Advanced, select Enable 508 Compliance.
Workflow Settings
About Workflow

In Verifier, you verify and correct batches failed in Runtime Server during Document Separation,
Classification, or Extraction.

« The workflow settings allow to define the processing of documents in Verifier.
« Eachworkflow step has an input and an output state.

« Theinput state must match the failure output state defined for the corresponding workflow step in
Runtime Server.

« After batch was successfully processed by the workflow step, Verifier assigns the specified output state
to the batch.

« This output state must match the input state of the subsequent workflow step in Runtime Server.

Activate and Deactivate Workflow Steps

To specify the workflow steps you want to perform at the current Verifier station, complete the following step.

1. Onthe Workflow tab, select one of the following options.
« Toactivate a step, click the corresponding button.

« Todeactivate a step, click the button again.

2. Optional. To add an input state, complete the following substeps.

1. Inthe Input State field, right-click and then click Add State.

2. Inthe Add State dialog box, enter a new input state and then click OK.
3. Optional. Toremove an input state, complete the following substep.

« Inthe Input State field, right-click and then click Remove State.
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Optional. To change an input state, complete the following substeps.
1. Inthe Input State field, right-click and then click Change State.

2. Inthe Change State dialog box, enter a new value and then click OK.

In the Input State field, select a value.

From the Output State list, select a value.

Under Verification rules, select the required options.
For more information, see Verification rules
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Verification Rules



You can select the following verification rules on the Workflow tab in the Settings dialog.
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Verify document for the lowest input verification state only

Select this option to verify a document using the lowest input verification state. When this option is
selected, the correction of the documents is grouped. After the verification of each input state, the user
is asked to release the batch even if there are still documents with a higher input state left to be
corrected. This option is valuable when you use several forms to verify extraction fields. If you have
several forms defined for default processing (meaning that this option is not selected) all forms will be

shown for the document that is corrected.

In the example shown below, first form 1 and afterwards form 2 for Document 1 is shown, afterwards
form 1 for Document 2 that has only Form 1. Then all forms for Document 3 will be shown.
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If this option is selected, the processing can be changed so that Form 1 for Document 1 is shown first,
followed by Form 1 for Document 2 and Form 1 for Document 3 until all documents of the lowest input
level are processed. Then the documents for the next input state and other forms are displayed for

correction, as in the below example.
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Use the DesignerVerifier Design Mode to design verification forms and to define which form is shown for
which input state, as in the below example.
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In the settings of the first Verifier form of this document class, Partial Validation is selected, and the
value is set (in this example the value is 210) which will be the output status for the document when
verification with this form is completed. When a document has the input state 210, the second
verification form is used to validate the fields. Therefore, the Process Step Filter was set to 210.

By default open the first available invalid batch and not the selected one

By default, the first available invalid batch is opened and not the selected one. The first invalid batch is
selected based on Priority (higher first), user's custom filter, sort settings and the Batch ID. This is for
projects with large amount of batches and simultaneous Verifier users. It decreases time delay of
project verification. This option is selected by default. And under Verification Mode, option “Verify first
invalid batch” is also selected by default. If the user changed the option from the Verification Mode, this
option will only remain valid for the current application session. As soon as the user quits the
application, the default behavior is re-initialized through the "By default open the first available invalid
batch and not the selected one" option.

Perform automatic extraction after classifying documents manually
Forces Brainware Intelligent Capture to attempt to automatically extract data after the Verifier operator

manually classifies the document.

Note: This option is only available if the Output State of the Classification Verification workflow
step matches the Input State of the Extraction Verification step.

Keep showing current document after saving

Displays the current document after performing a Save, instead of automatically displaying the next
document.
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Allow immediate copying of selected area to a field or table cell
Allows copying of a selected area to a field or table cell when verifying. Speeds up the process by
copying single words and candidates to verification elements.

Exception Handling
About Exception Handling

Use exception handling to deal with documents that fail in Verifier, such as documents with poor document
quality or missing information.

You can move such documents into an exception state to flag the batch for issues.

Having a mechanism for handling unexpected errors allows users to remove the batch from their task list.
Then, users can manually assign special states to documents.

Define Exception States

When defining an exception state, a menu command becomes available in the verification view. The menu
command allows for case-specific handling of various types of unforeseeable errors.

To select an exception state and set its description label, complete the following steps.

1. Onthe Exception Handling tab, in the Select states column, select the required check boxes.

Note: The available exception states cover the range from 601 to 699. A batch state corresponds to
the lowest document state within the batch. Routing batches using their exception state is only
possible if the state for successful verification is greater than the one used for exceptions.

2. Torename a description, right-click on the description and then click New description.

This description represents the menu item in the Move Document to Exception State menuin
verification view.

3. Inthe New description dialog box, enter the new description and then click OK.
Note: The maximum character length for the description is 128.

4. Select any of the following options.

Option Description

Before moving a documentto | Select this option to save a document automatically before moving it
an exception state, save it to an exception state.

automatically
Note: This applies to the current document only.




Option

Description

Create new batches with
documents marked for
exception handling

Select this option to move documents for exception handling to an
exception batch.

« Creates a batch for each exception code

« Each batch receives a new batch ID

« Documents from verified batches move to the same exception
batch in Batch View

« Batches release manually or automatically

When this option is not selected, documents for exception handling
stay in their batches. These batches keep their batch ID but receive
a new name according to the state description.

Automatically release all
available pending exception
batches that contain [XX] or
more documents or older than
[XX] minutes

Select this option to release an exception batch once it contains
more than [XX] documents or is older than [XX] minutes. This
allows critical exception documents to process without waiting for
manual intervention. Exception batches will also release when the
user logs out.

By default, set exception
mode to Batch

Select this option to change the scope of the command Move to
Exception State on the Options menu to Batch automatically.

Allow user selection of
exception mode (Batch vs.
Document)

Select this option to enable the dynamic changing of the exception
mode on the Options menu, document verification view. By default,
this option switches on. Use this option together with the option
above to preserve a specific exception mode for the different user
groups.

Supervised Learning

Configure Supervised Learning

To configure Supervised Learning, complete the following steps.

1.

To enable Supervised Learning, on the Supervised Learning tab, select Activate Supervised
Learning workflow.

Optional. In the Local project name field, enter or browse to the local project.

Note: Configure the local project with its own base directory (local learnset) and batch root.

Note:

Optional. To push the local learnset to the common learnset, select Distribute Local Learnset to
Knowledge base and then select any of the following options.




When selected, this option automatically adds any documents added to the local learnset into a queue
for the Learnset Manager to review if the documents are appropriate to be added to the global learnset.
The knowledge base is often referred to as a queue of accumulated documents or common learnset
pending review by the Learnset Manager for improvements into the project file.

« Inthe Knowledge base directory, enter or browse to the common learnset directory.

Note:
The common learnset updates whenever the local learnset is migrated to it.

« Optional. To prevent the learnset from being trained locally, select Nominate for the learnset but
never train locally.

« Optional. Select Use Database as knowledge source. This option enables the Select Job list.

Note:

To use this option, you need to have a job for a common learnset in the database. If this common
learnset job is not available, create a database job in Runtime Server with the common learnset
directory as the batch root.

Always show state of all field locations after opening a document is reserved for future
enhancements and not available yet.

To create a leamnset, select Apply local classification and extraction automatically.

Note:
When no local project or learnset is used, the global project and global learnset is used instead.

Now the SLW user can perform classification and automatic extraction in Verifier. Also, the SLM user
can now launch Leamnset Manager to verify the learnsets from the common learnset in the Accumulated
Documents Browsing mode.

To receive a notification in case of a discrepancy between script and your commands regarding the

population of the learnset, select Prompt if script forces or rejects insertion to Learnset.

Under Put document to Local Learnset, select one of the following options.

« Only if adding activated by a user: If selected, a document is added to a learnset when a user
requests it. The system displays a dialog box to confirm that the document should be added.

« Automatically if more than [X] % invalid fields: If selected, documents are automatically
added to the learnset if the number of invalid fields exceeds the specified number. The system
displays a dialog box to confirm that the document should be added.

Optionally select Always prompt before adding to display a confirmation dialog before the
document is added.

Under Learn new documents, select one of the following options.
« Only by user request: Select this option to initiate learning only when a user requests it.



« Before batch closing: Select this option to initiate learning for every batch in the project each time
any batch is closed.

« Immediately: Select this option to initiate learning anytime a document is added to the learnset.
Advanced Settings
Configure the Advanced Settings

To configure the advanced settings, complete the following steps.

1. To activate the project file updating feature, select Activate project file updating.
2. Inthe Source project file location field, enter or browse to the project.

Working with Verifier
About the Batch List

The batch list displays a list of batches, which is your work list, and appears after starting the Web Verifier.
Display the Batch List
To display the batch list, complete the following step.

e Onthe toolbar, click the Show batch list™"* icon.

Sort the Batch List

To sort the batch list by a column, complete the following step.

« Click on the column header by which you want to sort the list.

Note: If the batches in the list have different Priority values, they are always sorted first by Priority in
descending order and then by the column you clicked on.

Batch List Columns

Batch view columns display the following information about a batch.
Batch ID

A number for uniquely identifying a batch.
State

An integer between 0 and 999 that indicates the progress of batch processing. The state also indicates
whether the batch is ready for verification.
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Priority

An integer between 1 and 9 that indicates the urgency for processing a batch. 1 is the highest priority
and 9 is the lowest.

Name

An arbitrary name that is easier to read than the batch ID.

Folders

Folders organize documents in a batch. The value in this column indicates the number of folders inside
the batch.

Documents

The value in this column indicates the number of documents inside the batch.

Client

The owner of the BIC license. Contains N/A; not in use yet.

Last user/Module

This displays the most recent person or computer, and application that processed the batch.

Last Access
Displays the latest processing date.
The following columns do not display by default:

See " Additional Columns in Verifier or Web Verifier" in the Brainware Intelligent Capture Installation Guide for
more information.

External Group ID

The group ID relates to the security of the batch. It is a unique ID that assigns batches to a user group.

External Batch ID

The external batch ID is the name of the Batch Group. You can use this ID to represent any piece of
information you would like to associate with a batch, such as an external system ID or a storage box ID.

Transaction ID

Batches have transaction IDs to identify originators of batches of documents. This allows the developer
to synchronize a new batch of documents with another external system.

Transaction Type

Transaction Types helps to identify the type of documents in batches. This allows the developer to
synchronize a new batch of documents with another external system.



Batch List Icons

Anicon displays in front of each batch to indicate the status. When no icon is shown, the batch state is out of
workflow.

Symbol Status
) Batch is complete and ready for export.
1 Batch requires a correction of the classification
results.
) Batch requires a correction of the extraction results.

Batch is locked by another user or application and is
unavailable

& Batch contains documents with exception statuses.
To work on the batch, release it when it is
unavailable.

Navigate in the Batch List
To navigate in the batch list, perform any of the following actions.

« Togotothefirst batch page, click the First batch pageH button.

e Togothe previous batch page, click the Previous batch page 4 button.

Page| 1 |of2

« To navigate to a specific page, enter a number in the Page field.

o Togotothe next batch page, click the Next batch page P button.
o Togotothe last batch page, click the Last batch page H button.

o Torefresh the list, click the Refreshr?'::-ﬁ—' button.

About Batch Filtering

The batch filtering conditions affect the display of the batches.
This is useful for finding a subset of batches in a large job or for limiting the user's activities.

The filtering dialog box is accessible outside the settings dialog box so that users without a SET role but with
the FLT role can filter batches. Only users with the FLT role can configure filter conditions.

Saving the settings applies to the current batch view and saves for the next sessions.



Configure Batch Filter Conditions
To configure batch filter conditions, complete the following steps.

On the toolbar, click the Batch filter "}fl" button.

2. Inthe Batch Filtering Condition Properties dialog box, in the left pane, double-click to copy a field
name to the Select Filter Condition field.

3. Intheright pane, double-click to copy an operator to the Select Filter Condition field.
4. Inthe Select Filter Condition field, modify the condition according to your needs.

Example To see only batches at a state of 550, add the following condition.

[State]=550

5. Optional. To clear the filter condition settings, click the Clear Condition button.

6. Optional. Within the Group Settings section, administrators can easily define filter conditions for
several user groups.

1. Select a group from the drop-down list.

2. Click Configure Filtering.

3. Establish the filtering conditions and confirm by clicking Apply.
4. Click Save to save your settings.

Remove a Filter
To remove afilter, complete the following steps.

1. Onthe toolbar, click the Batch filter 2F button.
2. Click the Clear Condition button and then click OK.

Access Predefined Filters
To access a predefined filter, complete the following step.

e Onthe toolbar, click the arrow next to the Show batch list™=* button and then select the required filter.
Batch List Toolbar Buttons

The toolbar provides quick access to frequently used commands.

Label Description Button

Settings Opens the Verifier properties dialog box. i

Batch filter Opens the Batch Filtering Condition ar
Properties dialog box.




Label

Description

Button

Show batch list

Displays the batch list.

Verify batch

Start the verification of the currently
selected batch.

Depending on the batch state, the batch

is either displayed in the classification
window or in the indexing window.

The drop-down list offers the
following options:

« Verify first invalid batch: Select
this option to verify the batch with
the highest priority, regardless of
which batch is selected in the list.

« Verify selected / next batch:
Select this option to verify the
selected, respectively the next batch
in the list.

Show document list

Displays the structure of the current
batch.

Selecting a document shows the
document view, which provides an
overview of the documents inside the
batch.

H

Start Learnset Manager

Starts Learnset Manager.

First batch page

Navigate to the first page.

Previous batch page

Navigate to the previous page.

Next batch page

Navigate to the next page.

Last batch page

Navigate to the last page.

Y| Y A | A

Refresh

Refresh the batch list.
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Batch List Keyboard Shortcuts

The following shortcuts are available in the batch list.

Keyboard Shortcut Command
Ctrl + 1 Switch to Batch List View
Ctrl + 2 Switch to Verification Mode
Ctrl+3 Switch to Document Separation Mode
Ctrl+ N Restore Focus
F5 Refresh
Ctrl+ E Release Exception Batches
About the Verification View

In the verification view, you can correct the classification and extraction results.

When opening verification view, the classification window displays automatically if the next document
requires a correction of the classification result.

The class selection list in the lower pane shows the classification result of the current document.
Work with the Verification View

In the verification view, you correct the classification and extraction results. To display the Verification View,
complete the following steps.

1. Select a batch from the list that requires verification.

2. Click the Verify Selected Batch "' button.
Depending on the state of the document, the classification or indexing window opens.

3. Optional. To increase or decrease the image area, drag the vertical bar between the field pane and the
image pane either to the right or left.

4. |If the classification window is displayed, from the class selection list in the lower pane, select the
correct class.

Note: You can also enter the first characters of the required class name to limit the number of classes
displayed.

5. Ifthe indexing window is displayed, the document requires a correction of the extraction result. Correct
the invalid fields.



Customize the Verification Viewer Pane

To adjust the magnification used to display documents, complete any of the following steps.

To adjust the document to window height, click the Fit to height ¥ putton.
To adjust the document to window width, click the Fit to width“* button.
To adjust the document to best fit, click the Best itk button.

To zoom in, click the Zoom in - button.

To zoom out, click the Zoom out - button.

To display the next document with the currently selected magnification, click the Keep ZoomL - button.
To keep the focus on the document area associated with the currently selected field, click the Keep
Focus on Field"® button.

Navigate Through the Document

To navigate through the document, perform any of the following actions.

To go to the first document page, click the First Page in Documentl®!' button.

To go to the previous batch page, click the Previous Page in Document < putton.

Page| 1 |af3

To navigate to a specific page, enter a number in the Page field.

Note:

All invalid entries, for example alphabetical characters and page numbers out of range, are ignored,
and the page number is reset to the currently displayed page.

To go to the next batch page, click the Next Page in Document #| button.

To go to the last batch page, click the Last Page in Document =1 button.

To rotate the image, click the Rotate Image™ L button.

Navigate in the Batch

To navigate in the batch, perform any of the following actions.

To go to the first document in the batch and switch to Browsing Mode, click the First Document LL
button.

To go to the previous document in the batch and switch to Browsing Mode, click the Previous
Document * button.

To go to the next document in the batch and switch to Browsing Mode., click the Next Document
button.



o Togotothe last document in the batch and switch to Browsing Mode, click the Last Document ‘ﬂ
button.

Move a Document to an Exception State

If a batch contains a document that you cannot correct, for example because it belongs to none of the defined
classes, you can move this document to an exception state.

For more information, see Define exception states.

1. Onthe toolbar, from the Move Document to Exception State@ ¥ list, select the required exception.

2. Click the Move Document to Exception State@ ¥ button.

About the Class Selection List

The class selection list in the lower pane shows the classification result of the current document.

Opening the drop-down list displays all available classes.
Correct Classification Results

To correct invalid classification results, complete the following steps.

Prerequisite
Ensure that the Classification Verification workflow step is active.

For more information, see Activate and deactivate workflow steps
1. Optional. To display only batches that require correction, click the arrow next to the Show batch list
" button and then select Batches to Verify, Classification Only.
2. Inthe batch list, select a batch and then click the Verify Selected Batch "' button.

The verification view displays the first invalid document.

3. Inthe lower pane, complete one of the following substeps and then press Enter.
« From the drop-down list, select the correct class.

« Type the first characters of the class name and wait until the system automatically displays the full
name.

The application validates the document and updates the state. The next document requiring verification
displays automatically.
4. Repeat the previous step for all documents displayed.

5. After verifying all the documents in the batch, in the Brainware Intelligent Capture Verifier dialog
box, complete one of the following substeps.

o Click Yes.

« Click the Details button, select one of the following options and then click Yes.
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« Torelease the current batch and open the next batch that needs verification, select Verify the
next invalid batch on the list.

« Torelease the current batch and display the Batch View where you can select the next batch,
select Close batch and return to the batch list.

« Tochange verification forms, select Verify this batch with the next verification form.
Correct a Classification Result Using Advanced Classification

To select a class result using advanced classification, complete the following steps.

Prerequisite
In Designer, select the Enable advanced classification in Verifier check box.

For more information, see "Enable advanced classification" in the Brainware Intelligent Capture Designer
Help.

1. Click the Classification Matrix button.

If the result was not 100 percent certain, a list opens up containing one or more classes. The class with
the highest probability is at the top of the list.

2. Select aclass and then click OK.

About Processing Documents with an Obsolete Class

Deleting a class will make the class obsolete. Often with Supervised Learning workflow, classes become
obsolete because the global project's configuration deletes or just does not insert the class.

The only way to process obsolete document classes is if the class still exists in the project that the document
is processing with. Information saves internally about the former parent class assignment, which makes it
possible to process obsolete document classes.

Classification Window Keyboard Shortcuts

The following keyboard shortcuts are available in the classification window.

Keyboard Shortcut

Command

Ctrl + Alt + Home

First Document

Ctrl + Alt + Page Up

Previous Document

Ctrl + Alt + Page Down

Next Document

Ctrl + Alt + End

Last Document

Ctrl + 1

Show Batches




Keyboard Shortcut

Command

Ctrl + 2 Verify selected batch.
Ctrl + 3 Show selected batch.
Ctrl+ N Restore focus

Ctrl + Add Zoom In

Ctrl + Subtract Zoom Out

Ctrl + Left Move Image to Left

Ctrl + Right Move Image to Right
Ctrl + Up Move Image Upwards
Ctrl + Down Move Image Downwards
Ctrl + R Rotate

Ctrl + Home First Page in Document

Ctrl + Page Down

Previous Page in Document

Ctrl + Page Up

Next Page in Document

Ctrl + End Last Page in Document

Ctrl+ M Show Selection context menu.

F3 Option available in Advanced Verifier. Show last
verified document.

F8 Option available in Advanced Verifier. Get last value
for selected field.

Ctrl + L Option available in Advanced Verifier. Apply local
extraction.

Ctrl+J Increase image area.

Ctrl+K Decrease image area.




Keyboard Shortcut Command

Ctrl+ A Option available in Advanced Verifier. Add
document to learnset.

F7 Reclassify document manually.

F9 Move to exception state.

Ctrl+E Release exception batches.

Ctrl+T Available in both Verifier and Advanced Verifier, but
enhanced functionality only available in Advanced
Verifier. Correct Table.

Ctrl+Q Option available in Advanced Verifier. Switch table
highlighting.

Ctrl+ Z Undo

About the Indexing Window

The indexing window displays fields and documents specific to your organization.

Depending on the state of a document, the indexing window displays automatically in the left pane if the next
document for processing requires a correction of the extraction result.

The indexing window uses the form defined in Designer.

A form contains the following main elements.

« Labels: Captions that help users identify form fields, viewers and tables.

« Viewers: Contains pieces of document.

« Fields: Displays the extracted data and allows to enter or edit the content. Fields might be either a text
field, table field, check box, list box, or a Yes/No selection.




About Fields

A field displays data and allows the user to enter or edit data. To understand fields and the different types,
refer to the following lists.

The following list explains the meanings of the colors and icons for both Web Verifier and Verifier.

« A red frame for Web Verifier and a blue arrow * icon for Verifier indicates the current field.

« A blue frame for Web Verifier and a green check mark L% icon for Verifier indicates a valid field
extraction.

« A red triangle in the right upper corner for Web Verifier and a red ® icon for Verifier indicates a field
that is needing validation because of its low confidence extraction.

The following list explains the field types.

« A usercannot edit or select a Read Only field.

« A Auto-completion field enables the user to edit text by typing the first few letters of a word until best
matching candidate appears.

« A Multi-line field enables line wrap and displays a vertical scroll bar. This field type is a requirement for
address analysis.

« A List box contains a selection list to verify an item in a document.
« Check boxes are toggle selections for data input that derive from form fields.

Navigate Through the Fields
To navigate through the fields, complete any of the following actions.

« Usethe mouse. This method does not affect the validation state of a field.

« Press Tab. This method gets you to the next field, but not to the next document. This method does not
affect the validation state of a field.

Note: The order that the Tab key moves through the form is defined in field properties. For more
information, see "Add a form field" in the Brainware Intelligent Capture Designer Help.

» Press Shift + Tab to go to a previous field.

o Press Enter. This method validates the entire field or the next invalid character within a field. Once the
field is correct, it validates and the focus moves to the next field that requires correction. This field may
also be within another document.

About the Document Pane

The document pane shows the currently selected document or page along with highlights.

« Red areas indicate an invalid result.
o Green areas indicate a valid result.

« Yellow areas were considered as candidates, but another candidate seemed more likely. If the extraction
result is invalid or wrong, these areas may point to the correct indexing data.



Note: In practice, red, green, and yellow areas never appear in the same document.

About Tables in the Document Pane

Only one table will display per verification form, even if you are able to define multiple tables. However, you
can display different tables on different forms.

If you only need to verify certain columns in a table, you can make the other columns invisible. All invisible
columns must be valid for the entire table can be valid.

For a large document with many line items, you can detect and view the location of all the extracted line items
that are currently shown within a table field.

Increase or Decrease the Image Area

To increase or decrease the image area, complete the following step.

« Dragthe vertical bar between the image area and field area either to the right or left.
Highlight Fields and Candidates

To highlight the areas on the current document that have been used to fill the fields, complete any of the
following steps.

Note: Valid areas highlight in green and invalid areas highlight in red. These areas may also contain validity
icons, which are green check marks for valid fields or red Xs for invalid fields.

« To highlight all areas that have been used to fill the fields, on the toolbar, click the Highlight All Fields =
button.

If the result is valid, the area highlights in green. If the result is invalid, the area highlights in red.

« To highlight only the area that has been used to fill the currently selected field, on the toolbar, click the
Highlight Selected Field=! button.

If the result is valid, the area highlights in green. If the result is invalid, the area highlights in red.

« To highlight the candidates for the currently selected field, on the toolbar, click the Highlight Candidates
button.

This area either appears in green or in red. In addition, all other areas that were taken into account to fill
this field highlight in yellow.

« To highlight an entire table on the document, in the left pane, click the square in the upper-left corner of
the table field.

« To highlight a table column on the document, in the left pane, click the column label of a table field.

« To highlight a table row on the document, in the left pane, click the row label of a table field.

« To highlight a table cell on the document, in the left pane, click the cell of a table field.



Apply Local Extraction

To apply local extraction to the current document, complete the following step.
o Click the Apply local extraction ' button.

Add a Document to the Local Learnset

To add a document to the local leamset, complete the following step.
o Click the Add document to Iearnset_t button.

Learn a Document

To learn a document, complete the following step.
o Click the Learn Document & button.

Support of the Mouse Wheel

Verifier supports the mouse wheel when validating documents in document verification mode. Mouse wheel
rolling has the following effect depending on where the mouse cursor is or where the keyboard focus is.

Case Wheel rolling effect
Input focus is in a multi-line header field. Scrolls between lines of the header field.
Input focus is in a single line header field or at the Scrolls the entire verification form.

first line / row of any field (scrolling up only) or at the
last line / row (scrolling down only).

Input focus is in a table field. Scrolls between table rows or between multiple lines
of the currently selected table cell (when multi-line).

Mouse pointer is in the Document Viewer area. Scrolls the currently viewed page image up and
down.

About the Current Input Pane

The input pane below the document displays document area that relates to the field and provides a field where
the user can modify the field content.

Web Verifier and Verifier have a direct view control for viewing a large image area of the current field.




About the User Info Pane

The user info in the lowest pane displays three sections with the following information.

« The name of the currently selected field.

« If the current field is invalid, the reason is displayed. If the current field is valid, the section is normally
empty.

« The classification result of the current document.
Correct Extraction Results

Prerequisite
Ensure that the Extraction Verification workflow step is active.

For more information, see Activate and deactivate workflow steps
1. Optional. To display only batches that require correction, click the arrow next to the Show batch list
* button and then select Batches to Verify, Indexing Only.

2. Inthe batch list, select a batch and then click the Verify Selected Batch - button.
The verification view displays the first invalid document. The application places the cursor in the first
invalid field.

3. Verify and if required, correct the field content.
For more information, see Use a word that is a candidate for a field, Use a word that is not a candidate
for afield, and Insert blocks of text.

4. Repeat the previous step for all documents displayed.

5. After verifying all the documents in the batch, in the Brainware Intelligent Capture Verifier dialog
box, complete one of the following substeps.

« Click Yes.
« Click the Details button, select one of the following options and then click Yes.

« Torelease the current batch and open the next batch that needs verification, select Verify the
next invalid batch on the list.

« Torelease the current batch and display the Batch View where you can select the next batch,
select Close batch and return to the batch list.

« Tochange verification forms, select Verify this batch with the next verification form.

Form Elements and Field Types

A form has three main elements: a label, a viewer, and a form field. From a form field, you can select a text
field or table field. Using a text field or table field, you can create check boxes or combo boxes. The field types
for validation include Read Only, Auto-completion, Multi-line, Combo Box, and Checkbox. You can also add a
button to a form to fire actions.

A form can include the following elements.
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Form fields

Display extracted data. You can also enter and edit data during manual indexing. You can use form
fields to create checkboxes and combo boxes.

Labels

Identify form fields, viewers, and tables.

Viewers

Are sections of document areas, normally those that were extracted to fill fields or tables.

Buttons

Fire actions for a new script event.

Tables

Extracted from documents.
The following is a list of field types and their description.
Read Only

When selected, information on a field is dimmed and cannot be selected or edited.

Auto-completion

Enables you to edit text in a field by typing the first two letters of a word. Auto-completion finishes the
word with the best matching candidates.

Multi-line fields

Multi-line fields are necessary for address analysis but can also be useful in other cases. A multi-line
field enables line wrap and displays a vertical scroll bar, if required. To add a new line to a multi-line field
press Ctrl + Enter.

List box

A drop-down box that lists predefined strings related to the verification document. It can either show the
nearest values automatically or show only selected values.

Combo box

A combo box lists predefined strings related to the verification document. To aid in verification, you can
select from the list of strings.



Check box

A check box provides an either/or option that toggles table data entry choices on and off. For example,
with a Yes or No check box, checking Yes would bring up data entry related to the verification and
unchecked for No would hide them.
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Note: You'll notice a Vendor Search button in many of the illustrations. This button is created and
programmed in the BIC scripting language either for the Associative Vendor search or for the Multi-column
Associative search engine. In these illustrations, the button is used to quickly classify or reclassify. To leam
more about the scripting language, refer to the Scripting Documentation.

About Editing Text Fields

Verifier and Web Verifier include automated features for editing text fields that can speed up text entry and
correction.

You can use automatic character entry, when the auto-completion is selected in the form field Properties
dialog box, to edit text fields and cells. Other options for character changes include multi-line fields, combo
boxes, and check boxes. You can also insert and replace text in cells and fields, either in single words or
blocks of text, using drag-and-drop or by double-clicking on the selected text.

Multi-line fields are necessary for address analysis but can also be useful in other cases. A multi-line field
enables line wrap and displays a vertical scroll bar, if required. To add a new line to a multi-line field press Ctrl
+ Enter.

A Combo box lists predefined strings related to the verification document. To aid in verification, you can
select from the list of strings.

The Check box provides an either/or option that toggles table data entry choices on and off. For example, with
a Yes or No check box, checking Yes would bring up data entry related to the verification and unchecked for
No would hide them.
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About Auto-Completion

Auto-completion helps to speed up typing. When you start to type, auto-text completes the word, suggesting
the best match among all of the words or candidates available after the OCR process and Format Analysis.
For example, you can type the first two characters of a 20-character invoice. The auto-text feature finds the
best-matched candidate suggested by the Format Analysis engine and places it in that field.

The auto-selected text also appears highlighted in the original document. Select whether a single-line or a
multi-line text field should display. To override auto-completion, continue typing the desired text.

The auto-completion feature for a header field should automatically select the best candidate, which works
within Highlight Candidates mode. The viewer is only updated if the candidate appears once in the document;
otherwise, when the word for the field is inserted by auto-completion, the viewer will be blank.

Note: Auto-completion does not work on formatted text and characters incorrectly read by OCR.

About Inserting Words in Fields
To speed up verification, you can insert words to replace or append text.
The method for inserting words depends on the availability of candidates.

A candidate is one that matches the learned words for that field. It displays in green, with a border of green
check marks if that visual indicator is enabled in Batch Options, when you select it after selecting the field.

Non-candidates display in orange when selected.

You can insert words in fields or table cells. You can append or insert words and use the mouse to append or
replace the field.

To use the Append feature, the selected word must appear on the same line as the existing cell text. If not, the
selected word will replace the existing cell text.

« Words that are candidates for cells: If the word belongs in a cell area, you can append or replace a
word in a cell. The Append feature takes the current word behind the candidate and appends the cell text.
It places the text in the best location, either to the right or left of the word, and in the cell location based on
the text or location of the word. The word belonging to a cell area displays in green when selected. Or,
you can replace the text. In the search region, word candidates are all words that are not covered (by
location) by other table cells and that have the same beginnings as the whole text of the cell.

« Words that are not candidates for a cell: If the word does not belong to cell areas, it displays in orange
when selected. Eveniifit is not a candidate, you can append or replace the word. Appending places the
text in the best location, either to the right or left of the word, by text or location of the word. For example,
a cell named “C2658” might be appended by “number.” Or you can replace the cell text and location by the
text and location of a word.

Use a Word that is a Candidate for a Field

If the word is a candidate for a field, you can copy it into the field box. A candidate is a word that matches the
learned selections for the field. To copy text to the field box, complete the following steps.

Prerequisite Ensure the word fits the format analysis rules for the specific field.

1. Onthe document, click on the text you want to copy. A box appears around the word.



2. Double-click on the text or right-click in the text, and then select Copy to Current Field.
Note: You can insert only one candidate per field per document verification session.

Use a Word That is not a Candidate for a Field

Even if the word does not belong to any candidates for the field, you can append or replace a word with a new
one. Appending places the text in the best location, either right or left of the word, by text or location of the
word. Or you can replace the field text and location by the text and location of a word. A word that does not
belong to any candidates for that field will display in orange when selected. For example, a field named “sales
total” might be replaced by “invoice total.” To use a word that is not a candidate for field, complete one of the
following options.

« Toappend text with the new text, drag a box around the desired word. Double-click on the word in the
box, or right-click in the document and select Append Field Text by Word.

« Toreplace text, select the word with the mouse. A box appears around the word. Double-click it, or
select Replace Field Text by Candidate in the shortcut menu.

Note: You can insert only one candidate per field per document verification session. Make sure that
this word fits the format analysis rules defined for that field. If not, the word is highlighted in orange
(and with a border of orange exclamation marks if validity icons are enabled) to help distinguish it. If
s0, it would not be a good candidate for the field.

Insert Blocks of Text

Inserting blocks of text is helpful when working with multiple data verification elements. To insert blocks of
text, complete the following steps.

On the document, drag over the text.
2. Optional. Use the handles to adjust the selection.

3. Toreplace the selected text in the field or table cell, complete one of the following substeps.
« Drag the selection to the field or table cell.

« Double-click on the selection.
About Smart Indexing

Organizations, in particular commercial ones, usually collect legions of information about themselves and
everybody they do business with. Much of this information is stored in databases. There will rarely be a
company without a customer database that contains addresses, contacts, and so on. Financial transactions
are also recorded in databases. Databases can be an excellent support for indexing because they store
related information that can easily be retrieved. During indexing, if you have one piece of information from a
document, you can obtain related pieces from the database and fill the associated fields automatically. This
method is called smart indexing.

Normally, smart indexing is combined with manual indexing. Some fields of a form have to be filled in
manually; some fields can be filled automatically.



For example, let's assume that your organization saves information related to orders in the database of its
ERP system. Every order is characterized with a unique identifier and some attributes about the supplier and
the items that have been ordered. Soon after an order is placed, the ordered items are delivered, and a delivery
note is attached. The corresponding invoice follows soon. Delivery note and invoice refer to the original order.
They have the order’s unique identifier printed on them. With this identifier, you can look up supplier
information from the database when you verify the delivery note and invoice. However, new information such
as the invoice date has not yet been entered into the database. This information can be supplied manually.

Use Smart Indexing
To use smart indexing, complete the following steps.

1. InVerification View, in the left pane, select a smart index field.

Note:

The key 7 icon indicates a smart index field and the yellow cylinder ISI icon marks the fields that
can file through the database lookup.

2. Ifthefieldis still empty, enter the field value. Alternatively, enter a wildcard expression, using a * to
represent a sequence character or a ? to represent a single character.

3. Perform one of the following actions to start the lookup.

« If your application is configured accordingly and the field content is correct, press Enter to validate
the smart index field.

o Press Alt + F12.
4. The system responds with one of the following options.
« If the lookup yields no results, a corresponding message displays. Fill the lookup fields manually.

If you cannot complete the fields, send the document to exception handling.

« If the lookup yields one result, the lookup fields are filled.

« If the lookup yields multiple results, and this is allowed in your application, the lookup fields are
filled.

« If the lookup yields multiple results, and this is not allowed in your application, a dialog box appears
and you can select the correct record. The lookup fields will fill accordingly.

Indexing Window Keyboard Shortcuts

The following keyboard shortcuts are available in the indexing window.

Keyboard Shortcut Command

Ctrl+P Print

Ctrl + Alt + Home First Document




Keyboard Shortcut

Command

Ctrl + Alt + Page Up

Previous Document

Ctrl + Alt + Page Down

Next Document

Ctrl + Alt + End

Last Document

Ctrl + 2 Verification Mode

Ctrl + 1 Batch List View

Ctrl+ 3 Document Separation Mode
Ctrl+ N Restore focus

Ctrl+L Apply local extraction

Ctrl + A Add document to learnset
Ctrl +J Increase image area

Ctrl+ K Decrease image area

F9 Move to exception state
Ctrl+ E Release exception batches

Check Entire Batches

To check all the documents in a batch, complete the following steps.

1.
2.

In Batch View, select a batch from the list that requires verification.
Click the Verify Selected Batch " button.

Verification View displays the first document requiring correction.

To display the first document in the batch, click the First Document [k button.

Optional. You may encounter a document with incorrect classification.

« For Verifier, press F7 to open the classification window. Next, select the corresponding entry from
the drop-down list in the lower pane, and then press Enter to confirm.

« ForWeb Verifier, select Reclassify Document Manually from the Options menu. Next, select
the corresponding entry from the list at the bottom, and then press Enter to confirm.

This displays the indexing window.

Correct the extraction results by typing into the corresponding fields, and then press Enter to validate.




« For Verifier, press F3 to return to the document.
6. Go tothe next document and repeat the previous steps.
« For Verifier, press Ctrl + Alt + Page Down.

« ForWeb Verifier, click the Next Document * button.

About manual correction of classification and extraction results

Simultaneous correction of classification and extraction results are available if your workstation is configured
with the following settings.

« Classification verification is enabled.

« Extraction verification is enabled.

« Automatic extraction after classification is disabled.

« Todetermine your settings, check the Workflow tab of the Settings dialog box.

Note: If this option is enabled, extraction will be carried out automatically. In this case, classification
verification and extraction verification are two separate steps.

Note: If you do this task regularly, you may want to apply the appropriate filter in the Batch View using the
menu command View > Batch Filter > Batches to verify.

About Working with Tables

You can verify tables in the same way you would correct an invalid header field.
Additional methods to simplify manual table extraction, such as Correct Table, are available.

If automatic table extraction fails to recognize the line items properly, Verifier provides several ways for
convenient manual table correction.

About Auto-Completion with Tables

Auto-completion works in table cells and with text fields. When you type two or more characters, auto-
complete suggests a word or phrase for that cell.

The candidate appears in green if the field is valid and red if the field is invalid. If the visual validity icons are
enabled in Batch Options, valid fields also have a border of green check marks and invalid fields have a border

of red question marks. This function only works with Highlight Candidates —' mode.
Insert Candidate Words in Table Cells

You can insert single words or append existing text in table cells. To insert words in table cells, complete the
following steps.
1. Toselect the text you want to insert in a table cell, complete one of the following actions.

« Double-click on the word.

« Right-click on the word in the document pane and select the respective option.



« If you have candidates, double-click the desired candidate to replace it.
2. Toappend the selected text to the cell text, select Append Cell Text by Word.
3. Toreplace the cell text with the selected text, select Replace Cell Text by Word

Insert Non-Candidate Words in Table Cells

Even if the word does not belong to any candidates for the cell, you can insert single words, append or replace
existing text in table cells. To insert words in table cells, complete the following steps.

1. Toappend the selected text to the cell text, double-click the word or right-click in the document pane.

2. Select Align & Copy to Current Field.

3. Toreplace the cell text with the selected text, select the word, right-click and then click Copy to
Current Field.

Correct the Table Structure

To correct the structure of a table, complete any of the following steps.

o Tounmap a column, right-click the column header and then click Unmap Column.

This clears all data for the selected verification column and turns the state of the corresponding column
of the recognized table back to unmapped.

To view an unmapped column, double-click on the table header in the verification form. All unmapped
columns highlight in red.

« Toadd the column selected from the shortcut menu, right-click the column and then click Map Column.
You can also right-click on an unmapped column to map it to a column in the verification form.

« Toexchange the position of the current column, right-click the column header, click Swap Column, and
then select the column you want to exchange the current column with.

« Toinsert an empty row above the current one, right-click the row number and then click Insert Row.

« Todelete arow, right-click the row number and then click Delete Row.

« Toappend an empty row at the bottom of the table, right-click any row number and then click Append
Row.

« Tomerge rows, select the required rows, right-click any row number and then click Merge Rows.

o Toinsert an empty cell above the selected cell while shifting the cells below down, right-click the cell
and then click Insert Cell.

« Todelete a cell and shift up the cells below, right click the cell and then click Delete Cell.



About the Rubber-Banding Feature

The rubber-banding feature allows you to select a block of data by clicking and dragging on a document and to
place this block of values at a particular point within the table.

Note:

The Table Correction mode must be switched off for the menus described in the following topics, though a
mixed usage of manual and engine driven table correction is possible.

Auto-Scroll with the Rubber-Banding Feature
To auto-scroll when using the rubber-banding feature, perform one of the following actions.

« If the target document area displays partially, move the mouse outside of the document area while
rubber-banding to scroll the document and to select the data.

« Tore-size arubber-banded area, drag the corner of the rubber-band rectangle. The window will auto-
scroll to select values outside of the visible area.

About Adding Column Data to a Table
There are two ways to add column data to a table.
Insert Column Table Data

If whole rows are missing after extraction, use this option for better accuracy. Note that the application
observes the relationship between the columns and maps the values appropriately. Already extracted
cell values would be shifted up or down by the insertion creating new rows. See the insertion behavior
described below.

Replace Column Table Data

This is very comfortable when at least one column has been extracted by 100%, and other table
columns contain random values. With this option, the column data can be added blockwise, overwriting
the previously extracted entries.

Insert Column Data
Toinsert column data, perform one of the following actions.

o Toinsert column data above a correctly extracted and filled cell, click into the filled cell and select Insert
Column Table Data from the menu. This creates additional rows and shifts already existing rows up. At
the same time, the values will be automatically assigned to already extracted values of other columns if
available (green frame in the screenshot below).

234553 | .
345434 [F453653] ] . 4
456323
934543
840002
356989
655894

BEEEAEE




o Toinsert column data below a correctly extracted and filled cell, click into the next empty cell below and
select one of the two options depending on whether or not you want to keep already extracted cell

entries.

1] AT5040 ] 4
_2 C550403

3 0359403

4| F34553 E940589

_5 345434 F453653 |
B| 456323

7| 934543

_E 940002

_5 356589

10| B59594

Replace Column Data
To replace column data, complete the following step.

« Click acell as the starting point and select the Replace Column Table Data option. This will overwrite
existing cell values.

Since the rubber-banding area spans more lines than the table contains, the additional subsequent lines
will add as additional rows.

Insert or Replace Column Data
Toinsert or replace column data, complete the following steps.

1. Inthe left pane, place the cursorinto the destination cell within the table.

Description | Single Price | Quantity [Total Price =
234553
345434 138.56
456323 I 4
834543 D‘E
940002
3965963 i
E59894 i

[~i|em| o] a] w]ra|—=

2. Onthe document, click and drag around the column data you want to add to the table.
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3. Complete one of the following substeps.
« Toinsert the selected data, right-click the selection and then click Insert Column Table Data.

« Toreplace the datain the cell, right-click the selection and then click Replace Column Table
Data.

Insert Data from Split Columns

To insert data from columns of one data type that are split up and placed side-by-side or stacked, complete
the following steps.

1. Inthe left pane, place the cursorinto the first line of the column.

Example

[T | K

2. Onthe document, drag around the first block of column data.
Example

Test Tompany DL Taating Bod,  Boatan MADQR1SS

[LEETEEN
A5EIZE A 14
1€%.13 PETLTE ] HA45344 165, P14.04
402,83 B40003 1343453 A SEE. A5
§26.34 IEEBED 892345 T 103
£€91,.24 [0 2] | =L LT

3. Right-click the selection and then click Insert Column Table Data.

The mapping result looks like in the following example.



934567
356454
842039
234553

4. Toappend further column data, right-click the row’s node of the last table row and select Append Row.
5. Place the cursor into the next empty cell of the desired table column.
6. Onthe document, drag around the next block of column data.

Example

Test Qompany 10 Tasting Bwd.  Boatan MALZ106

Bafrance  Bawois A, Toanl
S34567 R75040 13. 14.
156454 “5504 JES. 164,31
842039 155403 33,56 402,89
234553 ES4 J 231.4 42€.34
145434 resild Lt ¥ €%1.24

7. Right-click the selection and then click Insert Column Table Data.
8. Ifrequired, repeat the previous steps with other columns to fill the table.

Insert Data in Partially Extracted Columns

To correct data for column items that are partially extracted, complete the following steps.

1. Inthe left pane, place the cursor into the already extracted cell to mark the starting point for the
insertion.

2. Onthe document, click and drag around the column data.

3. Right-click the selection and then click Insert Column Table Data.

4. Repeat the previous to map other column data.

Example To add the column data under the cell F453653, select the next empty cell below as the
starting point and repeat the steps from above.

1] J4553
Tt Company 113 Tarting bvd. Eaten MADI10E _} T FA53653
[3] =3
kewoicw lio, Batpryrey  brepie Ard Isial [] eaea3
TR RTR ¥ 1 (5] awonz
A2 " LAE 4%2.n ":'_":“:"'
M 0301 3.4 424,24 Tl e

Insert Missing Values
If column items are missing from a neighboring column, complete the following steps to insert missing values.

From the ‘Reference’ column, only the value from line 9 is extracted, and the ‘Invoice No.’ values from lines 4
— 8 are missing. To insert the ‘Reference’ values from lines 2 — 8 as a block, complete the following steps.

1. Place your cursor into the "reference"” cell in line 2.
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2. Onthe document, click and drag around the column data.
3. Right-click the selection and then click Insert Column Table Data.
Rows appear for the missing "Invoice No." values while shifting "reference" cell /892345 down.

1| 934567 |
[2| 36454 [[550403 | _ | -
3| 842033 |D359403 =
3 E940589
5 F453E53
B (3455940
7 HB45344
8 1345453
9| 356989 |JB92345
10| E59894

Correct Misaligned Columns
To correct data columns that appear misaligned, complete the following step.

o Map the column data as described in previous topics.

Invoice No.

934587

356454

242035 Reference
L750405
C550403
0359403

About Correcting Single Cells

You may also need to correct the table structure if for instance an unnecessary cell has been mapped to the
table or if a missing cell has to be added.

As in the example below, you may have documents where one of the line items is missing. During extraction,
the values from below might be shifted up to fill the empty space.
Test Company 115 Tasting Bud. Boaton MAGZ10S

TLEA 5 2550403 155.TH 343,33 B34 %43 HE45344 16590  B14.0

i

LE 402 .9% ] E T3454%5] 4.45 Sen. 4%
dI5E 4 TLET L] 23,43 42€, 04 136500 L
1454 24 F453553 6.5 453,24 | FLESET] K344 245, 9

To correct this, you have the possibility to insert or delete single cells.
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Delete a Single Cell

To delete an unnecessary cell, complete the following steps.
1. Inthe left pane, in the table, click into a cell.

2. Right-click and then click Delete Cell (Shift Cells Up).

Insert a Single Cell
Toinsert a cell, complete the following steps.

1. Intheleft pane, in the table, click into a cell.
2. Right-click and then click Insert Cell (Shift Cells Down).
This creates an empty cell above the selected cell.

About Table Extraction and Correction

The learning process for the Brainware Table Extraction engine consists of two phases.

« Learninglines
« Learning mappings of columns
These are discussed in detail in the following topics.

Note:

This functionality is available for Supervised Learning Verifiers. With the Generic Table Extraction, no extra
learning is needed.

About Lines
The Brainware Table Extraction engine considers the following main types of the lines.
Primary line

A line that defines table structure. The engine applies advanced and precise similarity analysis for all
primary lines. It is important that all primary lines are well-structured and that they look similar in many of
the rows to extract. The engine easily supports an unlimited number of types of primary lines for one
table definition. The primary line must contain at least four words. Otherwise, the engine will not learn it.
In addition, the primary line must be the first line in the table row.

Secondary line

A line between primary lines. The engine applies smooth similarity analysis for these types of lines,
which is possible because Brainware Table Extraction only searches the area between two neighboring
primary lines. This allows the engine to extract data that varies widely, which often happens with multi-
line descriptions. There is also no limit to the number of words in secondary lines, and no limit to the
number of secondary lines. However, a document's page must have at least one primary line;
otherwise, secondary lines on this page are not extracted.



Wrong line

A primary line that is learned as a negative line sample. In other words, all lines classified by the engine
as members of one particular “wrong” line class are not extracted. In principle, it is possible to learn an
unlimited number of wrong lines, though the current restriction is that this will only take effect during in-
document learning. Cross-document learning (that is, learning the whole document after all the fields are
completely valid) may not automatically train the wrong lines.

After it learns any type of line, the Brainware Table Extraction engine automatically creates and manages a
new line class (cluster). Afterward, all lines in the document considered by the engine to be members of the
line class (similar to the learned line sample) will be extracted, or not extracted in the case of “wrong” lines.

It is possible to learn an unlimited number of different line classes. However, the overall quality may suffer if
too many lines are learned.

Learning lines can be applied in lines learing (or lines highlighting) mode. Mapping of the column data in the
lines can be done in column mapping learning (or columns highlighting) mode. The user can switch between
learning (highlighting) modes with the Switch Table Highlighting menu option in Verifier Options menu or with
the context menu options Show Lines and Show Columns.

About Learning Column Mapping

When learning the mapping for columns, the user trains the engine on how the data from the extracted lines
must be mapped to the user's table data.

For primary lines, this mapping can be defined differently for different line classes. For example, if a user
learned two different line samples that went to two different lines classes internally in one document, the user
can then map “Unit Price” in the document to the “Unit Price” data column and the “Total Price” to the “Total
Price” for the first line sample. For all lines of the second line type, the user can map “Unit Price” to “Total
Price” and “Total Price” to “Unit Price.” For the next document, the Brainware Table Extraction engine will
always use mapping rule #1 for the lines classified to the first line type and mapping rule #2 for the lines
classified as the second line type.

If you have several Brainware Table Extraction tables in one class, the learnset is shared between these
tables. In other words, if you used interactive learning for one Brainware Table Extraction table, cross-
document leaming, which happens if the system added the document to the learnset after document
validation, is applied for all Brainware Table Extraction tables in the document.

About Correcting Fields in Tables Created with Brainware Table Extraction

Any time you train a table interactively, complete the required training first and then manually verify the table.
Brainware Table Extraction can train line types and column mapping for each type of line.

When working with interactive table extraction, learn the lines before you map the columns.

Because of the way interactive table verification works, you cannot manually delete data from a cell. Rather,
if you want to discard cell data, unmap the column and re-extract the table to remap the column. Although it
will seem as if you deleted the data, the data is still be there until you unmap the column.



Use the Standard Method for Table Extraction

The standard method for table extraction is the simplest way to use interactive Brainware Table Extraction
learning. To use the standard method, complete the following steps.

Show the first row sample.

Learn mapping.

Learn missing lines.

Learn and adjust the mapping of missing or wrong columns.

Apply corrections.

o9k wh-=

Learn the document.

Show the First Row Sample

To show the first row sample, complete the following steps.

1. Toselect the Brainware Table Extraction table, click any table field inside the table grid.

Click the Correct Tables _11' button.
3. Double-click the first row and select the Learn As Row function to show the row sample.

Note: Turning off the Correct Tables button causes the loss of learned rows and columns. Turning
the Correct Tables button back on leads to the loss of mapped table data.

4. Optional. Tolearn a new line as a primary line, right-click any gray line on the document, and then select
Learn Line.

5. Optional. To learn a block of lines as primary lines, drag over the primary lines on the document, right-
click, and then select Learn as Primary Line(s).

6. Optional. To learn a block of lines as a table row, drag over the primary lines on the document, right-
click, and then select Learn as Row.

Note: Do not try to learn the rest of the missing secondary or primary lines now. If you attempt to train
all different line samples now, you would need to learn the columns mapping separately for every line
class. If you first learn the column mapping for the row you just learned, the next time you learn
another line sample, the engine tries to apply existing mapping rules for the newly learned row
automatically, significantly reducing the time to train the table.

Learn Mapping

To highlight the row you learned, complete the following steps.

1. Right-click aline and select Show column.
2. Mark the location of the first cell item in the row you learned.
The system displays a special mapping control asking for the data column to extract the data to.
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3. Right-click the first cell item in a column. Choose Map Column, select the required data column, and
then click the selection.

4. Repeat the steps for the cell items in the first row.

Learn Missing Lines

Tolearn if text is missing from a row, complete the following steps.

1. Switch to the lines highlighting mode.

Note: Pressing Ctrl + Q switches the highlighting between three modes: cells, lines, and columns.
Press Ctrl + Q twice to switch from columns learning to lines learning.

2. Mark the next missing row and leamn it as before.
3. Repeat the steps for all rows on all pages, and then continue if nothing is missing.

Adjust Mapping

To adjust the mapping of a missing or incorrect column, complete the following steps.

1. Return to columns mapping learning mode.
2. Findincorrect or missing mapping, and then correct the mapping.

3. If you can’t map the missing columns, switch back to the lines highlighting mode, and then learn the row
where the mapping is missing.

4. Switchto columns highlighting. If the mapping is still missing, mark the missing part and map it.
Note: The Brainware Table Extraction engine may determine the mapping automatically.

5. Repeat steps until the data is completely extracted. The extraction results may not reach 100 percent.

Apply Corrections

To apply corrections and validate table fields, complete the following steps.

1. Switch to cells highlighting mode and manually correct missing data and OCR errors.

Note: Do not use interactive learning because every Brainware Table Extraction learning action
reactivates extraction and replaces all your manual inputs instantly.

2. Tovalidate the table, press Enter.

3. Optional. Click the Add Current Document to Local Learnset button to add the document to the
learnset and then learn it, which is known as cross-document learning. Do this if the system did not
suggest learning the document automatically.
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Note: The only requirement for cross-document learing is correctness and completeness of the table
data to train. This means that location, content, and format of every cell item is accurate.

Learn the Document

After table learning and validation are complete, you may want to add this document to the learnset and then
learn it. This is known as “cross-document” leaming, in contrast with “in-document” interactive Brainware
Table Extraction learning.

o If youwant to learn a document that the system did not automatically learn (the Add Current Document
to local learnset button is not cleared), you can activate learning by clicking Add Current Document to
Local Learnset.

Note: The only requirement for cross-document learning is correctness and completeness of the table
data to train. This means that location and content of every cell item should be correct. Also, ideally,
the content of cell items should not be formatted.

Advanced Learning with Brainware Table Extraction

Itis necessary to use secondary lines explicitly when a row begins on one page and ends on the next, or when

learning an unmapped secondary line leads to an extraction. Refer to the following cases to understand more
about these circumstances.

Case 1: A row begins on one page and ends on the next

If a table row begins on one page and ends on the next page, you must use the Learn as Secondary
Lines function in lines learning mode to train missing secondary lines.

In this case, these secondary lines appear right before the first primary line on the page. Mark all the
secondary lines by right-clicking and selecting Learn as Secondary Lines.

Note: Never use the Learn as Row function in this case, as this tells the engine that the first secondary
line is actually a new sample of primary line. As a result, the engine may split table data into new rows.
Case 2: Learning of unmapped secondary lines leads to unwanted extraction

Sometime the engine extracts data from secondary lines when its not a requirement for your project. In
this case, not learning these secondary lines prevents unnecessary extractions.

Use the Learn as Secondary Lines function instead of Learn as Row to learn certain lines. You can also
Unlearn Lines to correct or adjust the extraction.

Learn a Block of Secondary Lines

To learn a block of secondary lines, complete the following steps.

1. Onthe document, click and drag over the secondary lines of a multi-line row.
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2. Right-click on the selection and then click Learn as Secondary Line(s).
3. Optional. Repeat the previous steps if lines did not extract.

Unlearn a Line

Discard previously learning for a particular line with the Unlearn Line function. To do this, Brainware Table
Extraction uses a line sample, searches for the line type, and then removes the line type from the learnset.

To unlearn a line, complete the following steps.

1. Switchto Lines Learning mode.
2. Right-click on the line you want to unlearn and then click Unlearn Line.
Unlearned lines change from green to gray.

Learn a Line as a Wrong Line

Learning a wrong line means training the table to not extract particular lines. This applies to similar lines in the
table.

Tolearn aline as a wrong line, complete the following steps.
1. Right-click on any learned line or click and drag over multiple lines.
2. From the shortcut menu, select Learn as Wrong Line.

Note: These steps affect similar lines, which appear in gray.

About the Unmap Column Method
The Unmap Column method can undo mapping for the specified cell item.

This will undo mapping for all cell items that were extracted from the lines that belong to the same line type as
the cell item used to invoke the Unmap Column method.

Undo Column Mapping

To undo incorrect column mapping, complete the following steps.

1. Right-click on any column with a blue marking or draw a rectangular selection over the cell items.
2. From the shortcut menu, select Undo Mapping.

Result Columns highlighted in red turn blue when the mapping changes. Blue indicates a column without
mapping. The values no longer extract or display in the table grid.



Verification View Toolbar Buttons

The toolbar provides quick access to some frequently used commands.

Button Label

Description

Show batch list

Displays the batch list.

' Verify batch

Start the verification of the currently selected
batch.

Depending on the batch state, the batch is
either displayed in the classification window
or in the indexing window.

A drop-down list allows users to verify the
selected batch or verify the next invalid
batch.

]-n

Show document list

Displays the structure of the current batch.
Selecting a document shows the document
view, which provides an overview of the
documents inside the batch.

Start Learnset Manager

Starts Learnset Manager.

(% Rg Move Document To
Exception State

The scope of this command depends on the
Exception Mode set on the Options menu.
Two options are available: Move Document
to Exception State or Move Batch to
Exception State.

Clicking the arrow next to this button
displays a list of exceptions. You can use
these exceptions if you cannot correct a
document at all—for example, because it
belongs to none of the defined classes.
Check with your administrator to determine
which exceptions to use.

Note that in order to avoid selection
conflicts, only the toolbar button provides a
list of exception handling states to choose
from. The selection made here will also
apply if you move a document to exception
state by selecting the appropriate option
within the Options menu.




Label

Description

Highlight All Fields

Marks all areas on the current document that
have been used to fill the fields.

If the result is valid, the area highlights in
green. If the result is invalid, the area
highlights in red.

Highlight Selected
Field

Marks only the area on the current document
that was used to fill the field that is currently
selected in the field area.

If the extraction result is valid, the area
highlights in green. If the extraction result is
invalid, the area highlights in red.

Highlight Candidates

Marks the area that was used to fill the field
that is currently selected in the field area.
This area either appears in green orin red. In

addition, all other areas that were taken into
account to fill this field highlight in yellow.

I Fit to Height Fit the current image to the height of the
window.

N Fit to Width Fit the current image to the width of the
window.

] Best Fit Fit the current image to the width or height
of the window for maximum enlargement.

=@ Zoom In Zoom in on the document.

j Zoom Out Zoom out on the document.

- Keep Focus on Field If this button appears pressed down, the
application always displays the document
area that is associated with the currently
selected field.

l Keep Zoom Keeps the established zoom settings on
each document you view in the batch.
| First Page in Displays the first page of the document. This
Document button is only enabled if the current




Button

Label

Description

document has more than one page.

Previous Page in
Document

Displays the previous page in document.
This button is only enabled if the current
document has more than one page.

Page| 1

af 3

The text field allows you to enter a page
number in order to directly navigate to that
page. All invalid entries, such as alphabetic
characters or page numbers out of range,
will be ignored and the page number will be
reset to the currently displayed page.

Next Page in
Document

Displays the next page of the document.
This button is only enabled if the current
document has more than one page.

=

Last Page in Document

Displays the last page in document. This
button is only enabled if the current
document has more than one page.

Rotate Image

Rotate the current document clockwise.

First Document

Display the first document in the batch and
switches the application to Browsing Mode.

Previous Document

Display the previous document in the batch
and switches the application to Browsing
Mode.

Next Document

Display the next document in the batch and
switches the application to Browsing Mode.

Last Document

Display the last document in the batch and
switches the application to Browsing Mode.

Apply local extraction

Applies local classification and extraction to
the current document.

Add document to
learnset

Adds current document to local learnset.




Button Label Description

g Learn Documents Starts document learning.
+ Correct Table Starts table correction.
About the Document List

The document list displays the structure of the current batch.
Use the document list view to perform any of the following tasks.

« Display a document

« Split a multi-page document

o Append two documents

« Classify orreclassify a document

Display the Document List
To display the document list, complete the following step.

o Click the Show document list “aa™ button.

Access Predefined Filters
To access a predefined filter, complete the following step.

e On the toolbar, click the arrow next to the Show document list-aa™ button and then select the required
filter.

Customize the Document Viewer Pane
To customize the document viewer pane, complete any of the following steps.

o Todisplay the first page of the selected batch or a single page of the selected document, click the =
button.

» To horizontally display the first two documents of the selected batch or the first two pages of the
selected document, click the | button.

« To horizontally display the first three documents of the selected batch or the first three pages of the
selected document, click the 3" button.

o Tovertically display the first two documents of the selected batch or the first two pages of the selected
document, click the = button.



o To adjust the magnification used to display documents, complete any of the following substeps.

« To adjust the document to window height, click the Fit to height ¥ button.
« To adjust the document to window width, click the Fit to width® button.

« Toadjust the document to best fit, click the Best fitt= button.

e Tozoom in, click the Zoom in.';":':J button.

o Tozoom out, click the Zoom out.EJ button.

About the Batch Structure Pane

The batch structure pane displays an hierarchical representation of the batch contents.
The levels of the hierarchy are as follows.
« Batch
« Folder
« Document
« Page
Each document entry provides the following information.

« ID: A number that uniquely identifies the batch, folder, or document.

« State: Aninteger between 0 and 999 that indicates the progress of batch processing. The batch state
corresponds to the lowest value of all folder states and the folder state corresponds to the lowest value of
all document states.

« The batch or folder Name is an arbitrary name that is easier to read than the ID.
« Document Class: The document’s classification result.

Note: Depending on your access rights, the document view might list documents that are inaccessible. This
is due to their input states which are out of the workflow you have access to.

Navigate in the Document List

To navigate in the document list, perform one of the following actions.

o Toexpand or collapse a folder in, double-click on it, or click the plus sign or minus sign next to it.

« Perform one of the following actions.
« Tomove to the first document, press Ctrl + Alt + Home

o Tomove to the last document, press Ctrl + Alt + Home.
« Tomove to the next document, press Ctrl + Alt + Page Down.
« Tomove to the previous document, press Ctrl + Alt + Page Up.



Display a Document

To display a document, complete the following steps.
1. Intheleft pane, select a document.

The first page of the document is displayed in the right pane.

Note: It is possible to default Verifier to display a specific page of each document instead of the first
one. For more information, see “VerifierFormLoad” in the Brainware Intelligent Capture Scripting Help.

2. Optional. If the document contains more than one page, select the respective line in the left pane to
display the desired page.

About Splitting and Appending Documents

In the document list, you can cut multi-page documents into separate documents. You can also merge
consecutive pages of documents into one multi-page document.

Split a Multi-Page Document

To split a multi-page document, complete the following steps.

From the View, select Show Selected Batch > All Documents.
Select Show document list.
Click a multi-page document.
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Right-click a page in a multi-page document, and then perform one of the following actions.

« Select Cut pages into a new document. If the cut operation is unavailable, switch back to the
original sequence.

« Select Cut pages into new document keeping cover page. This option splits a single
document into several smaller documents and corresponding TIF files. It also includes the cover
page of the original document as the cover page for the new documents.

Note: To mark a page as a cover page, right-click on the first page of the document and select Mark
as cover page.

Append Two Documents

To append a document to another, complete the following steps.

1. Right-click the document to append, and then select Append this document to previous one.

Note: The append operation might be unavailable if changes were made to the sorting list. Switch
back to the original sequence.



Classify or Reclassify a Document

To classify or reclassify a document in the Document list view, complete the following steps.

1. Inthe left pane, select the document whose class you want to change.

2. Press F7 or double-click on the selected row in the Document Class column.
The available classes are displayed in the drop-down list.

3. From the drop-down list, select the required class.

Note: To automatically extract the document data after changing a class, select the Perform
automatic extraction after classifying documents manually option in the Verifier settings. For
more information, see Verification rules.

Viewer Toolbar Buttons

The viewer toolbar allows you to adjust the magnification used to display documents using the following
commands.

Button Label Description

I Fit to height Fits the document to window
height.

N Fit to width Fits the document to window
width.

] Best fit Provides the best fit for an
image.

jO) Zoom in Zoomsin.

2 Zoom out Zooms out.

Document List Toolbar Buttons

The toolbar provides quick access to some frequently used commands.

Button Label Description

i Settings Opens the Verifier properties dialog box.

Ar Batch filter Opens the Batch Filtering Condition Properties
dialog box.




Button

Label

Description

Show batch list

Displays the batch list.

Verify batch

Start the verification of the currently selected
batch.

Depending on the batch state, the batch is
either displayed in the classification window or
in the indexing window.

A drop-down list allows users to verify the
selected batch or verify the next invalid batch.

om

Show document list

Display the available filters for the batch
structure. You can select from among the
following options.

« All documents

« Documents to Classify

« Index Documents to Classify

« Documents to Index

Start Learnset Manager

Start Learnset Manager. This button is
available in Verifier only.

Single Page

Display the first page of the selected batch or a
single page of the selected document.

Two Pages Horizontally

Display the first two documents of the selected
batch horizontally or the first two pages of the
selected document.

Three Pages
Horizontally

Display the first three documents of the
selected batch horizontally or the first three
pages of the selected document.

Two Pages Vertically

Display the first two documents of the selected
batch vertically or the first two pages of the
selected document.




Document List Keyboard Shortcuts

The following keyboard shortcuts are available in the document list.

Keyboard Shortcut Command

Ctrl+P Print

Ctrl + Alt + Home First Document

Ctrl + Alt+ Page Down Next Document

Ctrl + Alt + Page Up Previous Document

Ctrl + Alt + End Last Document

Ctrl + 8 Append Document

Ctrl +9 Cut Document

Ctrl + Enter Accept/Reject next unsure page

Ctrl + Space Select next unsure page

Ctrl + 1 Display the Batch View

Ctrl + 2 Start the verification of the selected batch
Ctrl + 3 Display the selected batch in Batch View
Ctrl+ N Manually restore input focus without using the mouse
Ctrl + Add Zoom in

Ctrl + Subtract Zoom Out

Ctrl + Left Move Image to Left

Ctrl + Right Move Image to Right

Ctrl + Up Move Image Upwards

Ctrl + Down Move Image Downwards




Keyboard Shortcut Command
Ctn+R Rotate
Ctrl + Home First Page in Document

Ctrl + Page Down

Next Page in Document

Ctrl + Page Up

Previous Page in Document

Ctrl + End Last Page in Document

Ctrl+ M Show selection context menu

Ctrl + 2 Undo

F7 Reclassify manually (available in Advanced Verifier)

F3 Show last verified document (available in Advanced Verifier)
F8 Get last value for selected field (available in Advanced Verifier)
F9 Move to exception state

Ctr+E Release exception batches

Ctrl+ L Apply local extraction (available in Advanced Verifier)

Ctrl+ A Add document to learnset (available in Advanced Verifier)
Ctrl+T Correct tables

Ctrl+Q Switch table highlighting (available in Advanced Verifier)

Page Separation Workflow in Verifer

About Manually Correcting the Automatic Document Separation

To manually correct documents after automatic separation, navigate to Document Browsing mode. When the

next batch opens, the system will automatically display the first uncertain page split or merge.

When an entire batch retumns to the “failed document separation” state, that means the automatic separation
has at least one unsure page separation or merge. The Batch Fail ™ icon indicates that the batch will need a

manual validation.

Here, you have the following options.




« Toggle the unsure status

« Split the document into two separate documents
« Merge current document with the previous one

« Gotothe next unsure page

Working with Learnset Manager

About Supervised Learning

The basic purpose of Learnset Manager is to use Supervised Learning (interactive training) to improve the
quality and usefulness of your enterprise’s learnsets.

With Supervised Learning, Supervised LearningVerifiers, and Learnset Managers, you can customize your
project’s learnsets by adding or removing documents, reclassifying them or creating altogether new classes
or learnsets and migrating documents there. They can also promote local learnsets to a global learnset so that
it can be shared across the enterprise.

In general, Learnset Manager consists of:

« Creating new classes based upon documents themselves and supplier information.
« Learning documents and adding them to the local learnset.

« Using the local leamnset to improve the extraction of low-quality documents.

« Maintaining local learnsets.

« Updating and enhancing the global learnset with information from the local leamsets.

Although Supervised Learning was created for use with vendors’ invoices, it can also be used with other types
of knowledge. For example, a library might create classes based on type of material, subject matter, or
author. Most of the illustrations and examples in this chapter use invoices.

Learnset Manager is a separately licensed add-in that can only be launched from Verifier. You have access to
Learnset Manager mode only if you have been assigned to a group that has permission to work with the mode.
There is no limit on the number of users who can simultaneously access Leamset Manager.

Start Learnset Manager
To start Learnset Manager, complete the following step.
o Onthetoolbar, click the Start Learn Set Managerr * - button.

About the Learnset Manager User Interface

Learnset Manager has two basic modes, or views.
The Accumulated Documents view where you work with local learnsets.
The Global Learnset view where you work with common and global learnsets.

When you are working with local learnsets, you can further refine the appearance of the Accumulated
Documents Browser when you verify documents or manually reclassify them.
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Accumulated Documents Browsing

The Accumulated Documents Browsing view provides the following panes.

« The left pane displays the classes in the batch you are working on. This batch viewer shows each class
as part of the batch, the user who created the batch, the date it was created, the number of documents in
the batch and in each class, the number of documents successfully classified, and the number of
documents successfully extracted. You can enlarge the window to see all of these categories.

« Theright pane displays the current document. You can verify documents by clicking the Verify

Documents% button.

« Thelower pane displays the statistics. Her you can view the status of processed documents. A question
mark represents documents that are awaiting processing. Successfully processed documents have a
check mark, while documents that failed processing have an X.

Global Learnset Browsing

The Global Learnset Browsing view provides the following panes.

« Intheleft pane, you can see each class in the batch you are working on. This batch viewer shows the
classes in the global learnset, and the number of documents classified or extracted in each.

« Theright pane displays the current document. You can verify documents by clicking the Verify

Documents% button.

« Inthelower pane, you can view that status of processing documents in the Learning Statistics Viewer. A
question mark represents documents that are awaiting processing. Successfully processed documents
have a check mark, while documents that failed processing have an X.

Learnset Manager Keyboard Shortcuts

The following menu commands and keyboard shortcuts are available in Learnset Manager.

Keyboard Shortcut Description

Ctrl+E Closes Learnset Manager.

F5 Verifies documents in Supervised Learning.

F7 Manually reclassifies documents. Available to
Verifiers and Managers.

F1 Opens Learnset Manager Help.




Learnset Manager Toolbar Buttons

The Learnset Manager toolbar provides quick access to some frequently used commands.
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Description

Show Settings.

<

Switch to Accumulated Documents Browsing (the
local learnset).

Switch to global learnset processing.

Verify Documents. Activates the Advanced Verifier
mode.

Correct tables. Allows you to correct data in the
tables. You have to click a table field for this to be
active.

Accept documents.

MESE NI

Reject documents.

-
.-|:-

Learn documents. (Adds them to global learnset.)

Learnset Manager Viewer Toolbar Buttons

On the Viewer toolbar, you can use the following commands to adjust the size of a document relative to the

width of the Document Viewer window.

Button

Description

Fits the document to window height.

Fits the document to window width.

Best fit.




Button Description

j":') Zooms in. Alternatively, press [Ctrl] + [+].

,@ Zooms out. Alternatively, press [Ctrl] + [-].

Using Learnset Manager

About the Learnset Manager Process

Use Learmnset Manager to work with local learnsets: first, verify the documents, decide whether they belong in
the learnset, add them to the common learnset, and train the learnset.

In the common learnset, you examine the documents for inclusion in the global learnset, accept or reject
them, and add them to the global learnset. After that, you train the global learnset.

Configure Learnset Manager

To configure Learnset Manager, complete the following steps.
1. Toenable Supervised Learning, complete the steps in Configure Supervised Leaming.

2. Onthe Learnset Manager toolbar, click the Show Settings button.

Inthe Learn Set Manager Settings dialog box, select Show learned state using engine-level
information.

This setting indicates whether the system for learning was using a particular field or document. Also, a
user can disable learning.

4. Optional. To prevent adding documents to the learnset that are too large, select Automatically reject
document if number of pages exceeds and enter the number of pages in the field.
A message box is displayed when a document exceeds the number of allowed pages. The user can
decide to accept the document by clicking Yes.

5. Complete one of the following substeps.
« Toinherit the settings from Verifier, select thelnherit Verifier settings check box.

« Touse adifferent settings, set the following options.
« Inthe Global project path and name field, enter or browse to the global project.
« Tostore BIC core information in the database, complete the following substeps

1. Select the Use database as document and statistics source check box.

Note: To use the option Use database as knowledge source, the database needs a
job for a common learnset. If this common learnset job is not available, create a




database ‘job’ from RTS with common learnset folder as the batch root.

2. Optional. Select a job from the Select Job list.

« To set the path to the batch root, in the Accumulative (common) batch root path field, enter
or browse to the path.

Note:
This option is not available when using the database.

6. Under Automatic Backup, select the files to back up automatically.

Work with Common Learnsets

To work with common learnsets, complete the following steps.

Click the Switch to Accumulated Documents Browsing button.
In the left pane, select a batch to work with and then double-click a class.
In the lower pane, select a document.

The document displays in the right pane.

Optional. To activate Advanced Verifier, on the toolbar, click the Verify Documents% button and
then verify the document.

Complete one of the following substeps.

« To nominate the document for the common learnset, click the Accept Document\/ button.

« Toreject the document, click the Reject >< button.

In the lower pane. select another document from the batch and repeat the previous step.

N

After verifying all necessary documents, click the Learn ‘Af~ putton.
This promotes all accepted documents to the common learnset.

Result The Learn Statistics window for the local learnset is now empty.

Correct Tables

To correct tables, complete the following steps.

In the lower pane, select a document.
The document displays in the right pane.

In the right pane, click a table cell.
On the toolbar, click the Correct Tablesﬁ button.

Note: This enables Supervised Learning Managers and Verifiers to interactively train all the tables in a



document. Table correction in Learnset Manager proceeds just as it does in Verifier.

Reclassify a Document

To reclassify a document, complete the following steps.

1. From the Document menu, select Reclassify.
This opens a drop-down list below the document.

2. From the drop-down list, select a class and then press Enter.
About Accepting and Rejecting Documents

There are two ways to accept or reject a document or batch from a learnset.

« Using Verifier to manually screen and verify the document or batch.
« Comparing documents in the common learnset to the corresponding batch in the global learnset.

Sort Batches

Learnset Manager can sort by vendor name across multiple batches produced by different local Supervised
LearningVerifiers. This simplifies SLW decisions as to which documents to train for a specific vendor class.
With the help of this feature, the user can now review all documents for the same vendor class created by
different Advanced Verifier workstations at once.

The sorting options are available in Accumulated Document Browsing only.

However, in Global Learnset Browsing mode, the Vendor classes are sorted in alphabetical order.
Furthermore, under the Display Class Name column, class name is shown only for the document classes that
already exist in the global project.

To sort the batches, complete one of the following steps.

o Fromthe View menu, select Sort Batches by Vendor.

The system rebuilds the batches of documents created through multiple sessions by multiple Advanced
Verifier workstations and allows the Learnset Manager user to sort by vendor name. In this connection,
each vendor folder cumulates all available documents for this vendor, so that the user can select the
best documents to train the global project with.

The Created On and Created By data fields are displayed separately for each particular document in the
lower pane.

Work with Global Learnsets

The global learnset is where you further refine the quality of your data before migrating it into an effective and
useful global knowledge base. To work with global learnsets, complete the following steps.

1. Click the Global Learnset Viewing @ button.
2. Inthe left pane, select aclass.
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In the lower pane, select a document.

In the lower pane, right-click the document if you are satisfied with it, and then click Enable
Document.

B

In the lower pane, right-click the document and then click Use to Train Base Class.

Click the Learn & button.
Confirm learning the document by clicking Yes.
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After verifying each field in the document, click the Accept \/ button on the toolbar to accept the

document for processing, or click the Reject >< button to reject it.

9. Retrain the learnset by clicking the Learn & button on the toolbar.

Train Base Classes

The final milestone in creating or enhancing your global leamnset is to train base classes. To train a base class,
complete the following steps.

1. From the Options menu, select Train Base Classes.
2. Select the base class to train.
3. Under Train Selected Base Classes, select a value.

Note:
To avoid errors while maintaining the quality of your sample, select the lowest value possible.

4. Click OK.

Update Local Projects

The ability to update local projects is important for keeping your leamnsets in sync. During the work with
Verifier, the global project’s leamnsets are constantly updated.

An administrator may update the local out-of-date projects with a new global project.

The administrator adds all the local projects into the main list, points to the global project template for
overwriting, and then selects update.

To update local projects, complete the following steps.

1. From the Options menu, select Update Local Projects.

2. Inthe Update Local Projects dialog box, configure the selections described below and then click
Update. This procedure can take a while, especially if you are updating projects on a network.

Note: Locked projects will not update.

« Toadd project paths to the Update list, click the Add button and then select the project.
« Toremove paths from the Update list, click the Remove button and then select the project.
« Tochange existing project paths, click the Change button and then select the project.



« Toview ahistory of all Verifier workstations that connect to the common learnset, click the
History button. The history shows the workstation name, time, and date of its last connection.

« Too see the most recent information, click the Refresh button. This list updates every time a
Verifier station creates a new batch of locally learned documents in the common learnset.

« Toempty the template cache, in the Empty Template Cache Project field, enter or browse to the
project. This updates the local project.

3. Complete one of the following substeps.
« Toupdate the list of projects, click the Update button.

« Tosave the new criteria without actually updating the projects, click the Save button.

Result

Note: For each configured path, the dialog box shows whether a project is up-to-date, whether it is locked,
and whether the project is available. An up-to-date project has a green check mark and a out-of-date project
has a red X. Path names of unavailable projects are dimmed. Also, the settings above are available for any
workstation when Learnset Manager is open.

About Using Learnset Manager on Several Workstations

Learnset Manager can be used simultaneously on more than one workstation thanks to the application’s
ability to lock projects and files.

Learnset Manager supports three levels of protection that facilitate this ability.

« Batch-level locking.
« Allowing all Learnset Manager workstations to view changes made by all Supervised Learning Managers.
« Locking project files and learsets while they are being trained.

About Batch-Level Locking

Batches are locked when they are in process. This it prevents several users from updating the same batch at
the same time. No one else can access the batch until processing is completed and the batch is closed.

About Tracking Changes Made by Supervised Learning Managers

The changes applied by one Learnset Manager user should be visible to all other Learnset Manager users. To
accomplish this, Learnset Managers must use two predefined batch document states: “981, accepted” and
“082, rejected”.

When learning is executed, the Learnset Manager application checks to see if documents with either of these
assigned states have been added to the local learnset. Documents with a state of 981 are added to the global
learnset. Documents with a state of 982 are not added to the global learnset.

About Project File and Learnset Locking During Training

Only one workstation can do learning at one time. This means that the leaming process is locked, and
therefore not available for other users, if one user has initiated learning.
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Print a Document

To print a document, complete the following step.

1. Select File > Print.
Note: This function is not available in the batch list view.
2. Inthe Print dialog box, select the required settings and then click Print.

Configure Print Settings

To configure the print settings, complete the following steps.

The order that the fields print depends upon the order of the fields in the Form Design mode of the Designer
application.

When a document prints, the header includes the document file name and the document class.

1. From the File menu, select Print Setup.
2. inthe Print Setup dialog box, select any of the following options.
« Print image: Prints the pages of the document file.

« Print form: Activates printing of the verification form.

« Print hidden fields: Prints the visible fields on the current verification form and all the fields
available in the document.

« Print table fields: Prints the table fields.

« Print column header on each printed table page: This option is available only when Print table
fields is selected.

« Always show the dialog when printing: Displays the Print Setup dialog box when the users
presses print.

Troubleshooting

The tips in this topic can help to resolve some situations during the extraction and validation process.

In one of my batches, there is a document that must be classified manually, but it does not belong
to one of the available classes. What can | do to release the batch?

Normally, your organization will have specialized workstations where people are in charge of handling
special cases that only occur as exceptions.

In one of my batches, there is a document | have already validated. However, I’ve overlooked a
mistake in this document. | do not want to release the batch without correcting it.

You can use the Document Mode to get to the document. Select the document and switch to Verify
Mode. Make corrections and press Enter.



Sometimes the indexing window looks has no field area, only the current input area. How do | get to
the next field?

You can use keyboard shortcuts for field navigation from within the current input area.

When | switch from one field to the next, the document does not move. Is there a way to stop that?

The application searches the document area associated with the content of the current field. This area is
then displayed. To turn this off, select a different magnification ratio.

| tried to start Learnset Manager, but | do not want to go through Verifier. Can | do this?

No, the Learnset Manager can only be started in Verifier.

OK, | tried to start Learnset Manager in Verifier, this will not work. Why?

There are three reasons for this behavior.

« You may not have permission to use this add-in. Check with your project administrator to see if you
are assigned to a group that can work with Learnset Manager mode.

« Learnset Manager might not be enabled for the project. Again, contact your project administrator.

« A third reason might be that Learnset Manager mode is not properly licensed. Learnset Manager
gets its license through a Runtime Server process. If you've been able to get into to Learnset
Manager mode before, but you cannot now, it may be that Runtime Server has stopped.

Helpful Terms

ltems
Accumulated Learnset
A common learnset is known as a Accumulated Learnset.
Automatic Supervised Learning
This process uses the Associated Search Engine to process, classify, and extract information.
Base class
The highest level of a classification.
Batch

A batch is a stack of electronic documents. The electronic documents may be paper-based or files
created using applications.

Brainware Table Extraction

An extraction method that facilitates interactive table training.



Candidate

Set of possible values for a field.

Child class

A class spawned by a parent class. Also called a sub-class.

Class

A set of documents that are grouped by common content. Each class usually has a mnemonic name
that describes its contents.

Common Learnset

An accumulation of local learnsets.

DocClass

A parent document class.

Document

Any electronic file mainly consisting of ASCII text. If this is initially the case, OCR or filtering must be
applied to create the text representation classified, have fields used for extraction, and have one or more
images attached.

Export

The system no longer manages documents released by the export function.

Folder

A logical structure inside a batch for coherent documents. For example, a folder may consist of all pages
of a correspondence with many folders inside one batch.

Global Learnset

A general learnset that encompasses similar classes or projects. See also Local Learnset.

Learning

Given a view with a set of documents in vector representation and their class assignment, a neural
network is created, so that the defined classes can be reproduced without error. This neural network is
the used in all subsequent classification tasks.

Learnset

In classification, a leamnset is a set of documents whose class assignments are specified by the user.

For each view and each class, the user must provide a sufficient number of representative documents.
Similarly, in extraction, a learnset is a set of documents whose field contents are selected by the user

from a set of candidates.



Local Learnset

A learnset specific to a document class.

Neural network

An artificial neural network is an application that in some ways works like a human brain. This includes
the ability to learn. It consists of artificial neurons that are linked into a network of layers. The neural
network can receive signals through an input layer, process it within the internal layers, and send signals
through the output layer. During learning, a specified input (called a teacher signal, such as documents
from a Learnset) and the desired output (such as the corresponding classes) are presented to the
network together. Processing is then adjusted until the desired output can be produced from the teacher
signal.

Optical Character Recognition (OCR)

The reading and recognition of symbols of text from a piece of paper or a scanned image. OCR detects
the symbols and converts them into characters and words that can be read electronically.

Parent class

A class with derived class, called children.

Project

A collection of customer settings for applications. Projects are created in Verifier and sent to Runtime
Server for productive operation.

Smart Indexing

Smart indexing uses a database lookup to determine document attributes. It can be used for automatic
indexing and to support manual indexing.

Sub-class

A derivative class. Also called a child class.

Workdoc

An internal structure representing the logical structure of a document. The Workdoc represents the data
created during processing of a single document and contains all OCR and analysis results.

Processes
Analysis

Analysis means the document content is analyzed and a set of possible values for a field are generated
called candidates.
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Classification

Classification means assigning one or more classes and corresponding confidence values to one or
more unknown documents.

Evaluation

Evaluation means determining a class or the contents of a field from confidence levels, weights, or
distances for classes or candidates.

Extraction

Extraction means automatic document indexing and its information that helps to sort, file and search
documents.

Importing

Importing means bringing documents into the system for management and processing.

Indexing

Indexing means assigning attributes to a document. This can either be done manually, semi-
automatically (Smart Indexing), or entirely automatically (Extraction).

Validation

Validation involves confirming whether a processing result is correct.

Verification

Verification is related to quality assurance. It involves taking a processed document, checking the
processing results, and correcting any errors.

Toolbar Buttons

This is a quick reference to some of the commonly used toolbar buttons.

Main Controls

Icon Control
v Batch View
k Start Verification

]-n

Batch Structure

il Display Properties




Icon

Control

Display Batch Filter Dialog

Start Learnset Manager

First Batch Page

Previous Batch Page

Next Batch Page

¥y | Y| A &

Last batch Page

S

Refresh

Verification View

Icon

Control

(X

Exception State

Highlight Candidates

Keep Focus on Field

Keep Zoom

Previous Page in Document

Next Page in Document

Rotate Image (90 degrees)

First Document in Batch

Previous Document in Batch




Icon Control

| Next Document in Batch
| Last Document in Batch
¥ Correct Tables

Add Current Document to Local Learnset

Classify and Analyze Current Document

Document View

Icon Control
& Fit to Height
& Fit to Width
Ea Fit to Size
Y Zoom In
- Zoom Out
= Single Page View
Two Pages View horizontally
3 Three Pages View horizontally
Two Pages View vertically
0 Move Image Downwards

Move Image to Left




Icon Control
e Move Image to Right
ol Move Image Upwards

Learnset Manager

Icon

Control

Show Properties

Accumulated Documents Browsing

Global Learnset Browsing

Verify Document

Accept Document

XISl @ s B

Reject Document

- -
.-|:-

Learn Documents
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